
 

 โดยครูอาคม สวุรรณประเสริฐ ครู คศ.2 โรงเรียนสตรีประเสริฐศิลป์ จงัหวดัตราด 

 

1 การสร้างสือ่การเรียนการสอน ด้วยโปรแกรม CourseLab 

แนะน ำ CourseLab 

 โปรแกรม CourseLab เป็นโปรแกรมท่ีใชใ้นการพฒันาอีเลิร์นน่ิงท่ีใชง้านง่าย มีเคร่ืองมือต่างๆ มากมาย 

อีกทั้งสามารถเผยแพร่ไดห้ลายรูปแบบ เช่น ซีดี-รอม, อินเตอร์เน็ต และยงัใชง้านร่วมกบัระบบบริหารจดัการ

การเรียนการสอน (LMS) ไดอ้ยา่งดีเยีย่ม  และท่ีส าคญัเป็นฟรีแวร์ ซ่ึงหมายถึงสามารถน าไปใชง้านไดโ้ดยไม่

ตอ้งจ่ายค่าลิขสิทธ์ิแต่อยา่งใด 

 ลกัษณะเด่นของ CourseLab 

1. ท างานในลกัษณะ WYSIWYG (What You See Is What You Get)  

2. ผูใ้ชง้านไม่จ  าเป็นตอ้งมีความรู้ดา้นการเขียนโปรแกรม 

3. มีการ์ตูนเคล่ือนไหวในโปรแกรม เพื่อใชใ้นการประกอบการสร้างส่ือฯ 

4. สามารถน าไฟลมี์เดียต่างๆ เช่น Flash, Shockwave, Java และไฟลว์ดีีโอในรูปแบบต่างๆ มาใช้

ร่วมกนัได ้

5. สามารถทดสอบผลงานไดด้ว้ยตวัโปรแกรมเอง 

6. ใชท้รัพยากรเคร่ืองคอมพิวเตอร์นอ้ย 

7. สามารถออกแบบเน้ือหาอีเลิร์นน่ิงในรูปแบบโมเดลโครงสร้าง 

8. สนบัสนุนมาตรฐานอีเลิร์นน่ิงต่างๆ เช่น AICC, SCORM 1.2, SCORM 2004 (SCORM 1.3) 

9. สามารถเขียน Action เพิ่มเติมใหก้บัวตัถุในช้ินงานได ้

ท ำไมไม่ใช้ Captivate หรือ Authorware 

1. โปรแกรมทั้ง 2 เป็นโปรแกรมแบบพานิช เราตอ้งจ่ายค่าลิขสิทธ์ิในการใชโ้ปรแกรม ซ่ึงมีราคาแพง 

หรือถา้เราละเมิดลิขสิทธ์ิ ในขณะท่ีเราเป็นพอ่พิมพ-์แม่พิมพใ์หก้บัเยาวชนของชาติ ก็คง

ตะขิดตะขวงใจบา้ง  และเม่ือเราน าไปเสนอผลงานเพื่อของปรับวทิยฐานะ ก็อาจถูกตรวจสอบและ

ฟ้องร้องได ้

2. Authorware ไม่มีการพฒันาโปรแกรมใหมี้ความสามารถเพิ่มเติม 

3. Authorware ยงัยากส าหรับมือใหม่ 

4. Captivate และ Authorware ยงัมีปัญหากบัการรวมคะแนนในการสร้างแบบทดสอบ (โดยเฉพาะ

มือใหม่) 

 



 

 โดยครูอาคม สวุรรณประเสริฐ ครู คศ.2 โรงเรียนสตรีประเสริฐศิลป์ จงัหวดัตราด 

 

2 การสร้างสือ่การเรียนการสอน ด้วยโปรแกรม CourseLab 

กำรตดิตั้งโปรแกรม CourseLab 

 ขั้นแรกตอ้งจดัหาไฟลติ์ดตั้งของโปรแกรม CourseLab เสียก่อน โดยเราสามารถดาวน์โหลดไดฟ้รีจาก

เวบ็ไซต ์www.courselab.com หรือเปิดซีดีรอมท่ีแจกให ้ 

 

- ใหด้บัเบิ้ลคลิกท่ี courselab_2_installer รอสักครู่ท่ีมีหนา้ต่างปรากฏข้ึนดงัภาพดา้นล่าง

 
- กดปุ่ม Next 

 

http://www.courselab.com/
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3 การสร้างสือ่การเรียนการสอน ด้วยโปรแกรม CourseLab 

- กดปุ่ม Install เพื่อเร่ิมติดตั้งโปรแกรม 

 

- รอจนกวา่แถบสถานะของการติดตั้งเตม็ จะปรากฏหนา้หนา้ดา้นล่าง 

 

- กดปุ่ม Finish เป็นอนัส้ินสุดการติดตั้ง 
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4 การสร้างสือ่การเรียนการสอน ด้วยโปรแกรม CourseLab 

กำรลงทะเบียนโปรแกรม 

- เม่ือเปิดใชโ้ปรแกรมคร้ังแรก จะตอ้งมีการลงทะเบียนการใชง้าน โดยกรอกขอ้มูล ช่ือ, นามสกุล, 

ประเทศ, หน่วยงาน และอีเมลท่ี์ใชง้านไดจ้ริงในขณะน้ี (โปรแกรมจะแจง้ Register Code มาทาง

อีเมลน้ี์) แลว้กดปุ่ม Next

 
- หนา้ต่างน้ีใหก้รอกรหสัโปรแกรมท่ีไดรั้บจากอีเมล ์ในช่อง Code
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5 การสร้างสือ่การเรียนการสอน ด้วยโปรแกรม CourseLab 

- โปรแกรมจะข้ึนหนา้ต่าง Start Page       

 

กำรสร้ำงอเีลร์ินน่ิงใหม่ 

- คลิกท่ี Create a New Course… ท่ีหนา้ต่าง Start Page หรือคลิกท่ีเมนู File -> New -> Course… 

หรือ  ท่ีทูลบาร์ จะปรากฏหนา้ต่างดงัภาพ   

 
- กดปุ่ม Next > จะมีหนา้ต่างใหก้รอกรายละเอียดของอีเลิร์นน่ิง โดยกรอกช่ือวชิาในช่อง Name ช่ือ

โฟลเดอร์ของวชิาในช่อง Folder และในช่อง Location: ใหก้รอก (เลือก)ไดร์ฟ/โฟลเดอร์ท่ีใชใ้น
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6 การสร้างสือ่การเรียนการสอน ด้วยโปรแกรม CourseLab 

การเก็บส่ืออีเลิร์นน่ิง

 
- จะปรากฏหนา้ต่างท่ีใหก้ าหนดโมดูล (บทเรียน) โดยกรอกช่ือบทเรียนในช่อง Module Name และ

เลือก Template (รูปแบบส าเร็จของหนา้บทเรียน) แลว้กดปุ่ม Next >

 
- จะปรากฏหนา้ต่างการแกไ้ขเน้ือหาบทเรียนข้ึนมา ซ่ึงจะมีขนาด รูปแบบ ตาม Template ท่ีเลือก

 

แนะน ำส่วนต่ำงๆ ของโปรแกรม 
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7 การสร้างสือ่การเรียนการสอน ด้วยโปรแกรม CourseLab 

 การสร้างบทเรียน (Module) จะมี 3 ส่วนท่ีเราจะตอ้งจดัการคือ หนา้แรกของบทเรียน (Title) ซ่ึงแสดง

เป็นหนา้แรกของบทเรียนแต่ละบท โดยปกติจะเป็นหนา้ท่ีแสดงช่ือของบทเรียนนั้นๆ   แม่แบบของหนา้เน้ือหา

บทเรียน (Master) เป็นส่วนการก าหนดตน้แบบของหนา้บทเรียนแต่ละหนา้ ซ่ึงเราสามารถสร้างหนา้แม่แบบได้

หลายหนา้ และหนา้เน้ือหา (Normal) ซ่ึงเป็นหนา้ท่ีใชใ้นการใส่เน้ือหาของบทเรียน 

 เราสามารถเปล่ียนการแกไ้ขแต่ละส่วนไดจ้ากดา้นล่างของหนา้ต่าง Slide ดงัรูป 

 

 

 

กำรทดสอบสไลด์/บทเรียน 

 เราสามารถทดสอบการท างานของบทเรียนได ้ซ่ึงจะทดสอบเฉพาะสไลดท่ี์ก าลงัท างานอยู ่โดยกดปุ่ม 

Shift-F5  

 

 

 

Title Master Normal 

หนา้ต่าง Time Line ใชใ้นการ

ก าหนดเวลาการแสดงของแต่ละวตัถุ 

หน้าตา่ง Fame ใช้ในการ

เพ่ิมหน้าของแตล่ะสไลด์ 

หน้าตา่ง Slide ใช้ในการ

เลือกสไลด์ทีต้่องการแก้ไข 

หน้าตา่ง Course ใช้ในการ

เลือกบทเรียนที่ต้องการแก้ไข 

หนา้ต่างงาน Task pane ซ่ึงจะมีส่วนยอ่ย 6 ส่วน คือ  

- Frame Structure เพื่อเลือกวตัถุบนหนา้สไลด ์  

- Object Library เลือกวตัถุท่ีมีในโปรแกรมมาใชง้าน  

- Clip Art ใชก้ าหนดต าแหน่งรูปภาพท่ีใช ้ 

- AutoShape รูปทรงท่ีมีในโปรแกรม และ  

- Template ใหเ้ปล่ียนแม่แบบ 
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8 การสร้างสือ่การเรียนการสอน ด้วยโปรแกรม CourseLab 

 

 

หรือ เลือกเมนู Module -> View slide  หรือจะทดสอบทั้งบทเรียน ตั้งแต่หนา้แรกของบทเรียนจนจบสไลด์

สุดทา้ย โดยกดปุ่ม F5 หรือ เลือกเมนู Module -> View module 
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9 การสร้างสือ่การเรียนการสอน ด้วยโปรแกรม CourseLab 

กำรก ำหนดค่ำให้กบับทเรียน (Module) 

 การก าหนดค่าของบทเรียนจะมี 2 ส่วนดว้ยกนั คือ Design Settings และ Runtime Settings โดยส่วน 

Design Settings จะเป็นการก าหนดค่าในส่วนของการสร้าง-แกไ้ขบทเรียน  ส่วน Runtime Settings เป็นการ

ก าหนดค่าท่ีใชใ้นขณะบทเรียนก าลงัท างาน 

1. Design Setting 

- เราสามารถก าหนดค่า ไดจ้ากเมนู Module -> Design Settings… หรือกดปุ่น Alt+F7 

 
- ซ่ึงเราสามารถก าหนดได ้4 ส่วน คือ ขนาดของ Slide  
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10 การสร้างสือ่การเรียนการสอน ด้วยโปรแกรม CourseLab 

- ค่าเร่ิมตน้ของ รูปแบบฟอนต ์สไตล ์ขนาด และสีตวัอกัษร  

 
- ค าน าหนา้ช่ือวตัถุประเภทต่างๆ  

 
- และก าหนดถาดสี เป็นการสร้างสีท่ีเราจะใชง้านบ่อย ๆ ในการสร้างบทเรียน 

 
 

 

2. Runtime Settings… 
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11 การสร้างสือ่การเรียนการสอน ด้วยโปรแกรม CourseLab 

- เขา้ส่วนน้ีไดจ้ากเมนู Module -> Runtime Settings… 

 
 

 

 

 

- จะแสดงหนา้ต่าง Module Properties โดยมี 5 แทป็ ๆ แรก คือ General เป็นการก าหนดช่ือท่ีจะ

แสดงข้ึนมาโดยเฉพาะเม่ือให้กบัระบบ LMS ตอ้งกรอก ช่ือ (Identifier) และค าอธิบายโดยยอ่ของ

บทเรียน (Description) 

 
- แทป็ท่ี 2 จะเป็นการก าหนดตวัแปรท่ีใชใ้นการเก็บคะแนน ซ่ึงตวัโปรแกรมจะเตรียมไวใ้ห้ 1 ตวั  

คือ total และตามตวัอยา่งไดเ้พิ่มตวัแปรpretest เพื่อใชเ้ก็บคะแนนก่อนเรียน และ posttest ใชเ้ก็บ

คะแนนหลงัเรียน (สามารถก าหนดก่ีตวัก็ไดต้ามตอ้งการ เช่น เก็บเป็นรายจุดประสงค)์ 
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12 การสร้างสือ่การเรียนการสอน ด้วยโปรแกรม CourseLab 

  

 
 

- แทป็ท่ี 3 Rule  

 
- แทป็ท่ี 4 Checks เป็นการก าหนดรายการโปรแกรมท่ีบทเรียนของเราจะท าการตรวจสอบ ในเคร่ือง

ท่ีก าลงัท างานอยู ่

คลกิ เพื่อเพิ่ม 

Objective 

 

ปอ้นช่ือ ตวัแปร 

ใสค่ะแนนเต็ม 
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13 การสร้างสือ่การเรียนการสอน ด้วยโปรแกรม CourseLab 

 
- แทป็ท่ี 5  Runtime ในท่ีน้ีให้คลิกเอาเคร่ืองหมายถูกท่ี show Title-Slid at module startup ออก เพื่อ

ไม่ตอ้งใชห้นา้แรกบทเรียน (Title) เน่ืองจากการก าหนดล าดบัการแสดงผลของวตัถุต่างๆ บนสไลด์

ไม่สามารถท าได ้

 

 

กำรตกแต่งแม่แบบ 

 อยา่งท่ีกล่าวขา้งตน้ สไลดแ์ม่แบบ (Master Slide) เป็นตน้แบบของสไลดบ์ทเรียน ซ่ึงสไลดบ์ทเรียนท่ี

เราสร้างข้ึนตอ้งก าหนดวา่ใชแ้ม่แบบหนา้ไหน ดงันั้นเราจ าเป็นตอ้งมีแม่แบบไวอ้ยา่งนอ้ย 1 สไลด ์ ในท่ีน้ีเราจะ

สร้างแม่แบบวา่งๆ ไว ้1 สไลด ์เพราะเราจะออกแบบหนา้แรกเองทั้งหมด 

 โดยใหค้ลิกท่ี Master   จากนั้นคลิกขวาท่ีหนา้ต่างสไลด ์เลือกค าสั่ง New Master 
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14 การสร้างสือ่การเรียนการสอน ด้วยโปรแกรม CourseLab 

กำรตกแต่งหน้ำบทเรียน 

1. เปล่ียนแม่แบบใหก้บัสไลดแ์รก โดยการคลิกขวาท่ีสไลด ์ในหนา้ต่างสไลด ์เลือก Master 

          
2. การแทรกไฟลแ์ฟลช ในหนา้แรกน้ีเราคงตอ้งการสร้างความต่ืนตาต่ืนใจใหก้บัผูเ้รียนบา้ง  ฉะนั้นก็

ควรแทรกมลัติมีเดียลงไปในหนา้บทเรียน ในท่ีน้ีจะแทรกไฟลแ์ฟลช (สร้าง

ข้ึนจากโปรแกรมอ่ืน) โดยขั้นแรกใหป้รับหนา้ต่าง Task pane ใหแ้สดงส่วน 

Object Library เลือก Media แลว้จึงดบัเบิลคลิกท่ีไอคอน Flash ดงัรูป 

 

 

 

ซ่ึงจะปรากฏวตัถุ Flash ข้ึนในหนา้บทเรียน

ของเรา ดงัรูป 

เลอืกแมแ่บบ

ที่ต้องการแล้ว

กด OK 
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ใหด้บัเบิ้ลคลิกท่ีวตัถุ Flash จะมีหนา้ต่าง Flash-movie ข้ึนมา 

 

จากนั้นปรับขนาดของวตัถุโดยคลิกท่ีวตัถุ Flash นั้น แลว้คลิกคา้งไวท่ี้ปุ่มท่ีมุมของวตัถุแลว้ลากให้

ไดข้นาดตามตอ้งการ 

  

คลกิที่นี่ เพื่อ จะมีหน้าตา่ง Open ให้

หา และเลอืกไฟล์แฟลชที่เราต้องการ 

คลกิ OK  

และ OK 
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3. กำรแทรก Text Box  

การแทรกขอ้ความ ในสไลด์นั้น เราจะใชค้  าสั่ง Insert -> Text Box หรือจากแถบเคร่ืองมือ ก็

จะไดก้ล่องขอ้ความท่ีมีพื้นโปร่ง (เห็นเฉพาะขอ้ความ

อยา่งเดียว) ไม่มีกรอบ บนหนา้สไลด ์ ดงัรูป  ใหด้บัเบิ้ล

คลิกท่ีกล่องขอ้ความเพื่อแกไ้ขขอ้ความ จะปรากฏ

หนา้ต่างดงัรูปดา้นขวามือ  ใหแ้กไ้ข

ขอ้ความ เปล่ียนแบบอกัษร ขนาด รูปแบบ 

สี ฯลฯ ตามท่ีเราตอ้งการ เสร็จแลว้ใหก้ด

ปุ่ม OK เป็นอนัเสร็จเรียบร้อย 1 กล่อง

ขอ้ความ   ซ่ึงในหนา้น้ี เราจะแทรกกล่อง

ขอ้ความ 6 กล่องขอ้ความ (หรือมากกวา่น้ี

ตามตอ้งการ) คือ ขอ้ความแสดงช่ือเร่ือง

บทเรียน  “จุดประสงค”์  “แบบทดสอบก่อนเรียน”  “เขา้สู่บทเรียน”  “แบบทดสอบหลงัเรียน”  และ 

“ออกจากบทเรียน”  ดงัรูป 

 
4. กำรตั้งล ำดับกำรแสดงผลของวตัถุบนสไลด์ 

 

ขั้นแรกตอ้งจดัการใหแ้ถบเวลา (Timeline) แสดงออกมาก่อน โดยคลิกท่ีเมนู 

View -> Timeline หรือกด Alt + 2  
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จากนั้นคลิกคา้งท่ีดา้นซา้ยของแถบเวลา ดงัรูป 

  
ลากออกมา ใหไ้ดเ้วลาตามท่ีตอ้งการ 

  
เม่ือปล่อยเมาส์ จากไดผ้ลลพัธ์ดงัรูป 

 
ซ่ึงเห็นวา่วตัถุทุกตวัจะแสดงผลทนัที และแสดงจนจบสไลด ์หากตอ้งการก าหนดการแสดงผลของ

แต่ละวตัถุ ใหล้ากแถบสีเทาของวตัถุแต่ละตวัไปตามเวลาท่ีเราตอ้งการ โดยตอ้งไม่เกินจากเส้นเวลา

การแสดงผลของสไลด์ 

 
ดงัตวัอยา่งน้ี 

 
5. กำรเพิม่สไลด์ 

เม่ือเราตกแต่งหนา้สไลดแ์รกแลว้ ขั้นต่อไปเราจะตอ้งสร้างการเช่ือมโยง

ไปยงัหนา้ต่างๆ ตามท่ีตั้งหวัขอ้ไป  ซ่ึงเราคงตอ้งสร้างหนา้สไลดข์องแต่

ละส่วนไวร้องรับเสียก่อน คือ หนา้ “จุดประสงค”์ 1 สไลด ์หนา้

แบบทดสอบก่อนเรียน 3 สไลด ์(ค าแนะน า, ขอ้สอบ, ผลการสอบ) หนา้

บทเรียน 1 สไลด ์(จะเพิ่มภายหลงั) หนา้ แบบทดสอบหลงัเรียน 3 สไลด ์

และ หนา้เครดิตก่อนจบ 

การสร้างหนา้สไลดเ์พิ่ม เราจะคลิกขวาในหนา้ต่าง Slide ซ่ึงจะปรากฏ
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เมนูป้อปอพัข้ึนมา (ดงัภาพซา้ย) ใหเ้ลือก New Slide ก็จะไดส้ไลดใ์หม่ 1 สไลด ์(ดงัภาพขวา) ท า

เช่นเดียวกนัจบครบ  

6. กำรแก้ไขช่ือสไลด์  

เสร็จจากการเพิ่มสไลดแ์ลว้ ก็คงยงัไม่ไปสร้างการเช่ือมโยง แต่เราจะมาตั้ง

ช่ือใหก้บัสไลดเ์สียก่อน เพื่อความสะดวกในการอา้งอิง  โดยใหค้ลิกขวาท่ี

สไลดท่ี์ตอ้งการตั้งช่ือ แลว้เลือกเมนู Rename… (ดงัภาพซ้าย) จากนั้นจะ

ปรากฏหนา้ต่าง Slide ดงัภาพดา้นล่าง ใหพ้ิมพช่ื์อท่ีตอ้งการในช่อง Name: 

ท าใหค้รบทุกสไลด ์

 

 

 

7. กำรสร้ำงกำรเช่ือมโยง 

เราจะกลบัไปท่ีหนา้แรก โดยคลิกเลือกจากหนา้ต่าง Slide จากนั้น    

คลกิขวำ ท่ี Text Box แรก คือ ขอ้ความ “จุดประสงค”์ (ดงัภาพซา้ย)  

จากนั้นเลือก Actions…ซ่ึงจะปรากฏหนา้ต่าง ดงัภาพดา้นล่าง 

 

 

 

เราจะเลือกเหตุการณ์ 

(Event) onclick จาก

ดา้นซา้ย และเลือกการ

ท างาน (Action)  CALL

จากดา้นขวา  ซ่ึงจะหมายความวา่ เราก าหนดใหเ้ม่ือมีการคลิกเมาส์ท่ีขอ้ความ “จุดประสงค”์ 

บทเรียนของเราจะเรียกสไลด์/เฟรมใด (เด๋ียวเราจะไปก าหนดอีกที) ข้ึนมาแสดง 

การก าหนดสไลดท่ี์จะมาแสดง เราจะดบัเบิ้ลคลิกท่ี Call(Frame=’’,Option=’’) จากช่อง Object 

(ช่องกลาง) ซ่ึงจะปรากฏหนา้ต่าง Call  ใหค้ลิกปุ่ม เพื่อก าหนดเฟรม/สไลดท่ี์ตอ้งการ 
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ใหก้ดปุ่ม  หลงัช่อง Slide แลว้เลือก

สไลดท่ี์เราตอ้งการใหแ้สดง จากหนา้ต่าง 

Select Slide (ดงัภาพ) แลว้กด OK ทั้ง 4 

คร้ัง เป็นอนัเสร็จการเช่ือมโยง ใหท้  า

เช่นเดียวกนั กบั Text Box อ่ืนๆ 

 

8. กำรแทรกรูปภำพ 

ในหนา้ “จุดประสงค”์ เราจะท าการแทรก Text Box ท่ีเป็นขอ้ความแสดงจุดประสงคก์ารเรียนรู้ของ

บทเรียน โดยอาจใชไ้ฟลแ์ฟลช เป็นพื้นหลงั หรืออาจใชภ้าพเป็นพื้นหลงัก็ได ้

ฉะนั้นในขั้นตอนน้ีเราจะมาดูวธีิการแทรกรูปภาพลงในหนา้สไลด ์เพื่อตกแต่งสไลด ์(หากใช้

ประกอบขอ้ความเน้ือหา อาจใชแ้ทรกใช ้Text Box ได)้  ไม่วา่จะเป็นพื้นหลงั ภาพตกแต่ง หรือปุ่ม

ยอ้นกลบั ก็ตาม 

โดยใชปุ่้ม ท่ีแถบเคร่ืองมือดา้นบน จากนั้นหา-เลือกภาพท่ีตอ้งการจากหนา้ต่างท่ีปรากฏ

ข้ึนมาดงัรูป 
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9. กำรจัดล ำดับกำรซ้อนของวตัถุ 

หากเราแทรกวตัถุต่างๆ ลงบนสไลดแ์ลว้ ตอ้งการจดัล าดบัการซอ้นใหม่ เช่นตอ้งการใหมี้ขอ้ความ 

(แทรก Text Box ไปก่อน) อยูบ่นรูปลูกศร (แทรกภาพไปทีหลงัจึงอยูบ่น)  เราก็สามารถจดัล าดบั

บน-ล่างใหม่ไดจ้ากแถบเคร่ืองดงัภาพ  โดยปุ่มซา้ยมือสุด หมายถึง น าวตัถุท่ีเรา

เลือกใหไ้วบ้นสุด  ปุ่มท่ีสอง เอาไวล่้างสุด  ปุ่มท่ีสาม ยกข้ึน 1 ชั้น และเอาลง 1 ชั้น 

 

10. กำรใส่ Effect กำรแสดงผล 

นอกจากเราจะตั้งเวลาการแสดงผลของวตัถุแลว้ เรายงั

สามารถใส่เทคนิคพิเศษของการแสดงผลไดอี้กดว้ย เช่น 

ค่อยๆ แสดงผลเป็นแถบจากซา้ยไปขวา เป็นตน้ ซ่ึงเรา

สามารถใส่ Effect โดยคลิกขวาท่ีวตัถุนั้น แลว้เลือก 

Format Text Box… (หรือ Format Picture… กรณีเป็น

วตัถุรูปภาพ หรือ Format Object… กรณีเป็นวตัถุ

อ่ืนๆ) จากนั้นคลิกท่ีแทป็ Display แลว้เลือก Effect 

ในส่วน Entrance เพื่อใชเ้ม่ือเร่ิมแสดงผล และเลือก 

Effect ในส่วน Exit เพือ่ใชเ้ม่ือส้ินสุดการแสดงผล 

(ดงัภาพ) 

 

 

11. กำรสร้ำงกำรเช่ือมโยงเพ่ือกลับมำหน้ำเดิม 

ท่ี Text Box ท่ีมีขอ้ความวา่ “กลบัหนา้แรก” เราจะใส่ Action ท่ีช่ือวา่ RETURN (ยอ้นกลบัหนา้ท่ี

เรียก) โดยท าวธีิเดียวกนักบัการสร้างการเช่ือมโยงมาหนา้ “จุดประสงค”์ เพียงแต่ในส่วน Action 

ใหเ้ลือก RETURN ซ่ึงเราไม่ตอ้งก าหนดสไลดเ์ป้าหมายท่ีจะกลบั (ตอ้งใชคู้่กบั CALL) 
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12. ตกแต่งหน้ำ “ค ำช้ีแจงแบบทดสอบก่อนเรียน” และ “ค ำช้ีแจงแบบทดสอบหลงัเรียน” 

ในสองหนา้ท่ีเราจะใชว้ธีิการเดียวกนักบัการตกแต่งขา้งตน้ เพียงแต่ในส่วนปุ่มเช่ือมโยงท่ีเราใชใ้น

หนา้น้ี จะเป็นการก าหนดเช่ือมโยงไปยงัหนา้ถดัไป (Next Slide) 

 

กำรสร้ำงแบบทดสอบ 

 ในโปรแกรม CourseLab มีแบบทดสอบใหใ้ช ้6 แบบ คือ แบบหลายตวั

เลือกตอบไดต้วัเลือกเดียว และหลายตวัเลือกตอบไดห้ลายตวัเลือก แบบเรียงล าดบั แบบ

เติมตวัเลข แบบเติมขอ้ความ และแบบจบัคู่  โดยมีวธีิสร้าง 2 วธีิ คือ สร้างรายขอ้ (เหมาะ

ใชร่้วมกบับทเรียน) และสร้างเป็นชุด (เหมาะกบัการสร้างขอ้สอบ) 

 ในท่ีน้ีเราจะใชว้ธีิสร้างเป็นชุด ซ่ึงตวัแบบทดสอบจะอยูใ่นสไลด์ๆ  เดียวเท่านั้น 

โดยขั้นแรกตอ้งเลือก Object 

Library จาก Task Pane ก่อน คลิก

ท่ี Tests แลว้ดบัเบิ้ลคลิกท่ี Multiple 

Question Test  (ดงัรูปดา้นซา้ย) จะ

ปรากฏวตัถุดงัภาพ (ดา้นขวา) บนหนา้สไลด์ 

 ต่อไปเราจะเร่ิมสร้างขอ้สอบ โดยดบัเบิลคลิกท่ีวตัถุดงักล่าว ซ่ึงจะปรากฏหนา้ต่าง Test  ท่ีแทป็ 

Question ใหค้ลิกท่ีปุ่มเคร่ืองหมายบวก เพื่อเพิ่มขอ้สอบ  

1. ข้อสอบแบบเลือกตอบค ำตอบเดียว 

ใหก้ าหนด Question type: เป็น Single choice 

 

 

 

 

คลกิ เพื่อเลอืกชนิดของข้อสอบ ในท่ีนีเ้ลอืก 

Single choice (เลอืกได้ค าตอบเดียว) 

คลกิ เพื่อพิมพ์ค าถาม 

คลกิ เพื่อเพิ่มตวัเลอืก 

 

คลกิ เพื่อเพิ่ม

ข้อสอบ 
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และตอ้งมีการก าหนดการเก็บคะแนน โดยคลิกท่ีแทป็ Score 

 

 

 

 

 

 

 

ส่วนน้ีเป็นการก าหนดวา่จะเก็บคะแนนขอ้น้ีเท่าใด เก็บใน 

ตวัแปรใดบา้ง 

 

2. ข้อสอบแบบเลือกได้หลำยตัวเลือก  

จะมีขั้นตอนเหมือนกบัขอ้แรก ต่างกนัตรงท่ี Question type : เป็น Multiple select โดยการแสดงผล ช่อง

เลือกหนา้ตวัเลือกจะเป็นกรอบส่ีเหล่ียม 

3. ข้อสอบแบบเรียงล ำดับ 

คลิกเพิ่มขอ้สอบ แลว้เลือกชนิดขอ้สอบเป็น Ordering และในส่วนตวัเลือกให้เรียงล าดบัตามท่ีตอ้งการ

ใหน้กัเรียนเรียง (เม่ือแสดงผลโปรแกรมจะสลบัตวัเลือกเอง) 

แก้ไขข้อความ 

ข้อถกู 

สลบัตวัเลอืก 

จ านวนคะแนนท่ีได้เมื่อตอบถกู 

คลกิเพื่อเพิม่ตวัแปรที่ใช้เก็บคะแนน 

เลอืกตวัแปร 
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4. ข้อสอบแบบเติมตัวเลข 

   
 

 

 

 

 

 

 

5. ข้อสอบแบบเติมค ำ 

เลอืกแบบ Ordering 

ให้เรียงล าดบัตามที่โจทย์ต้องการ 

ข้อความอธิบาย 

เพิ่มช่องปอ้นค าตอบ  

(1 ข้อ มีได้หลายช่อง) 

เพิ่มค าตอบที่ถกู 

เลอืกเง่ือนไข  เช่น เทา่กบั ไมเ่ทา่กบั 

มากกวา่ มากกวา่หรือเทา่กบั  

น้อยกวา่  น้อยกวา่หรือเทา่กบั 

คา่ที่ถกูต้อง 

ความกว้าง 
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วธีิการสร้างขอ้สอบแบบเติมค า มีวธีิเหมือนกบัขอ้สอบแบบเติมตวัเลข โดยมีขอ้แตกต่างท่ีการสร้าง

เง่ือนไขตรวจสอบ คือ มีการตรวจสอบเท่ากนั เร่ิมตน้ดว้ย ปิดทา้ยดว้ย มีขอ้ความ รวมทั้งมีการ

ก าหนดการตรวจสอบตวัเล็กตวัใหญ่ให้ภาษาองักฤษดว้ย 

 
  

6. ข้อสอบแบบจับคู่ 

 

 

 

 

 

 

 

  

  

กำรสร้ำงรำยงำนผลกำรท ำแบบทดสอบ 

ใหห้นา้ “ผลการสอบ” ให้ดบัเบิ้ลคลิกท่ี Current Results จาก Object Library ส่วน Tests  

ซ่ึงจะมีวตัถุในหนา้สไลด ์ดงัรูปขวา 

 ใหด้บัเบิ้ลคลิกท่ีวตัถุดงักล่าว เพื่อ

ปรับแต่ง ซ่ึงจะปรากฏหนา้ต่าง  

เพิ่มคู ่ โดยโปรแกรมจะสลบัคู่

ให้เมื่อตอนแสดงผล 

คลกิเพื่อเปลีย่นตวัแปรที่น ามาแสดง 
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ดงัภาพดา้นล่าง 

  

 

 

กำรแทรกเสียง 

 เราสามารถแทรกเสียงใหก้บัวตัถุทุกๆ วตัถุ โดยคลิกท่ีแท็ป Sound ในหนา้ต่าง Format (คลิกขวาท่ีวตัถุ 

เลือก Format Object…) 

  

 

ปรับแตง่ข้อความ 

คลกิที่นี ้แล้วเลอืกไฟล์เสยีงจากหน้าตา่ง Open 
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